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Upgrading MobileFirst Server from V5.0.6 to V7.1.0

The installation of IBM MobileFirst Platform Foundation for iOS V7.1.0 is
different from the installation of IBM® Worklight® V5.0.6. The key difference is that
the functions of the Worklight project WAR file are split into three WAR files:

MobileFirst Server Administration Service WAR file
The Administration Service handles the management operations such as
uploading a new version of an adapter or an app (.wlapp), and changing
the active status of an application.

MobileFirst Operations Console WAR file
The console WAR file provides a web graphical interface to the
Administration Service. The Administration Service also offers a REST API,
and can be controlled with wladm command.

MobileFirst runtime WAR file
The runtime WAR file (also called the project WAR file) handles the
communication with the mobile apps.

The first two WAR files (the MobileFirst Server Administration Service and
MobileFirst Operations Console) are secured by using security roles in the
application server.

The data that is stored in the database is also different between the two versions.
There is a new set of database tables for the Administration Service. These tables
contain some of the data that is stored in the Worklight table in V5.0.6. The data
that is related to the push notification is also modified. The upgrade scripts are
available to convert the existing data to the new data model for the push
notification.

The new architecture requires that an Administration Service WAR file is installed
in each server where a runtime WAR file is installed. Also, all servers of a cluster
are symmetric, that is they must contain the same runtime WAR file. The servers of
a cluster must be federated as a server farm so that any administration change,
such as uploading a new version of an adapter, is reflected to all the servers of the
runtime environment. On WebSphere® Application Server Network Deployment,
however, you can use non-symmetric deployment and it is not needed to federate
the servers as a farm. For more information about the supported topologies, see
[Planning deployment of administration components and runtimes|

The WebSphere Application Server Liberty profile is no longer embedded in the
MobileFirst installer. If you use Liberty profile, you can install this application
server with its own installer. The installer is provided together with IBM
MobileFirst Platform Foundation for iOS electronic assembly.

In addition to these changes in the databases and the components of V7.1.0, you
might consider the following differences:

Product renaming
The product is renamed from IBM Worklight to IBM MobileFirst Platform
Foundation for iOS in V6.3.0.

Installation changes
V7.1.0 installer no longer deploys MobileFirst components to an
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application server. You do that in a second step, either with a graphical
tool such as the Server Configuration Tool, with Ant tasks (command-line),
or manually.

Changes in deployment scripts
The scripts to deploy adapters or the application in command-line are
different. Your deployment scripts need to be updated.

Removed environments
The following environments for hybrid applications are not supported in
V7.1.0: Apple OS X Dashboard, Facebook, Google, Windows Phone 7.5,
Windows 7, Vista.

Session-independent mode by default
New applications that are developed with V7.1.0 are session-independent
by default. This choice can be overridden. For more information, see
[Session-independent mode}

* This difference might have impact on:
— Your network infrastructure and the settings of your load balancers.

— The ability to auto-scale a cluster or server farm. For
session-independent applications, you can stop a server without
visible impact for the users.

— Your maintenance procedures. It is no longer true to assume that a
cluster that has some servers that are upgraded and other not
upgraded to a new configuration or fix pack level, has no impact on
existing sessions.

WorklightReports database is deprecated
If you rely on this database for application monitoring, consider installing
MobileFirst Operational Analytics. For more information, see
[[BM MobileFirst Platform Operational Analytics|.

Support for token licensing
Token licensing is introduced in V7.1.0.

 If you have a contract that defines the use of token-based licensing for
the product, activate token licensing at upgrade time and configure your
application for token licensing.

* If you do not have a contract that defines the use of token-based
licensing, do not activate token licensing at upgrade time. With token
licensing activated, MobileFirst Server does not start unless it is
configured to retrieve tokens from a Rational® License Key Server and
obtains enough tokens to run.

New network flow
The Administration Service and the runtime environment communicate via
JMX inside a server and also between the servers of a WebSphere
Application Server Network Deployment cluster or farm (for Apache
Tomcat, WebSphere Application Server Liberty profile, or WebSphere
Application Server stand-alone). The communication uses the following
protocol, depending on the application server:

* SOAP for WebSphere Application Server and WebSphere Application
Server Network Deployment

* RMI for Apache Tomcat
* HTTPS for WebSphere Application Server Liberty.

Note: In a Liberty farm, the HTTPS certificate of each server needs to be
embedded in its truststore.
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The Administration Service and the runtime environment communicate via
HTTP (or HTTPS) to serve large artifacts. The connection is opened by the
Administration service. If this communication needs to go through a
reverse proxy in your data center, you need to perform some
configurations after the applications are installed. For more information,
see [Defining the endpoint of the MobileFirst Administration services|

New startup behavior

At startup, the runtime environment communicates with the
Administration Service to get the list of applications and adapters to serve.
This operation is called the runtime synchronization. If the operation fails,
the runtime environment will not accept queries from the mobile devices.
To troubleshoot these startup issues, the trace settings must be activated
for the applications at startup.

To upgrade from V5.0.6 to V7.1.0, you uninstall V5.0.6, run IBM Installation
Manager, convert your data in the databases to V7.1.0 format, and then install
V7.1.0. The high-level procedure is as follows:

1.

10.
11.

12.

Prepare a rollback plan. You might want to make a backup of the database
before you run the database migration scripts.

Note: Some operations that are run in the migration scripts cannot be undone.

If you have applications for Apple OS X Dashboard, Facebook, Google,
Windows Phone 7.5, Windows 7, or Vista, prepare a replacement plan. These
environments are not supported after you migrate to V7.1.0.

Uninstall V5.0.6.

If you use Liberty profile that is embedded with V5.0.6, make a new
installation of the application server with the installer that is provided in the
electronic assembly for V7.1.0.

Run IBM Installation Manager.
Migrate the database content.

Install and configure the MobileFirst Server Administration Service and
MobileFirst Operations Console.

Migrate the V5.0.6 project WAR File (so that it is compatible with V7.1.0) and
deploy it to all servers.

Install MobileFirst Operational Analytics on a server other than the one that
runs the Administration Service and the runtime environment.

Restart the application servers

Verify that the installation runs correctly and that the connection between the
farm members works well.

After the migration is completed, the mobile devices that run your
applications can continue to use them. However, to deploy apps or adapters
that are developed with V7.1.0, you need to deploy a new Project WAR File.
For more information, see [Version compatibility]
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Running IBM Installation Manager

Before you begin

Prepare a rollback plan. You might want to make a backup of the database before
you run the database migration scripts as some operations that are run in the
migration scripts cannot be undone.

If you have applications for Apple OS X Dashboard, Facebook, Google, Windows
Phone 7.5, Windows 7, or Vista, prepare a replacement plan. These environments
are not supported after you migrate to V7.1.0.

Uninstall V5.0.6 with Installation Manager.

If you use Liberty profile that is embedded with V5.0.6, make a new installation of
the application server with the installer that is provided in the electronic assembly
for V7.1.0.

About this task

First, run Installation Manager to install the binary files of IBM MobileFirst
Platform Foundation for iOS on your disk to V7.1.0. Then, update the MobileFirst
Server components on your application server by following the steps that are
described in [“Updating the application server and the databases” on page 3-1)

Installation Manager can be run in two ways: by graphical user interface (GUI), or
by command-line. The effect of running Installation Manager to upgrade to V7.1.0
depends on the choice that you made at the initial installation.

The product is renamed from IBM Worklight to IBM MobileFirst Platform
Foundation for iOS in V6.3.0.

Running Installation Manager in graphical mode

Procedure
1. Run Installation Manager from the user account that is used at the initial
installation.

To apply an update, Installation Manager must run with the same list of
registry files that are used at the initial installation. The list of Software that is
installed and the options that are used during the installation time are stored in
those registry files. If you run Installation Manager in administrator mode, the
registry files are installed at the system level. In /var folder on UNIX or Linux.
In c:\ProgramData folder on Windows. The location is independent from the
user who runs Installation Manager (although root is needed on UNIX and
Linux). However, if you run Installation Manager in single user mode, the
registry files are stored by default in the user's home directory.

2. Select File > Preferences.

Enter the repository of IBM MobileFirst Platform Foundation for iOS V7.1.0 and
also the repository of the fix pack if you plan to upgrade to a fix pack or
interim fix. The fix packs are delivered as delta installers and cannot be
installed if the base version is not among the listed repositories.
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If you decompress the base installer in 710_installer_directory folder, the
repository file to enter is 710_installer_directory/
MobileFirst_Platform_Server/diskl/diskTag.inf. If you decompress the
interim fix file in ifix_directory folder, the repository file to enter is
ifix_directory/MobileFirst_Platform_Server/diskl/diskTag.inf.

3. After the repositories are entered, click OK to close the Preferences display.

4. Click Install. After you accept the license terms of IBM MobileFirst Platform
Foundation for iOS V7.1.0, Installation Manager displays a list of packages that
are already installed and can be upgraded. The package of Worklight V5.0.6
might be displayed if you still have the installation.

Note: Do not select such a package. Otherwise Installation Manager would
uninstall that package and reinstall V7.1.0.

5. Select the Create a New package group option and install V7.1.0 in that new
package group.

6. Click Next. You must determine whether you need to activate token licensing
or not. Token Licensing is a new feature that is introduced in V7.1.0.

* If you do not have a contract to use token licensing with the Rational License
Key Server, click Do not activate token licensing.

* If you activate token licensing, make sure that the Rational License Key
Server is configured, and enough tokens can be obtained to run MobileFirst
Server and the applications it serves. Otherwise, the MobileFirst Server
administration application and the runtime environments cannot be run.

7. In the Configuration Choice panel, select No to the Install IBM MobileFirst
Application Center option. If you plan to use Application Center, install it
with Ant tasks. Installing Application Center with Ant tasks, instead of
Installation Manager, enables you to decouple updates to the server from
updates to the Application Center.

8. Click Next until you reach the Thank You panel and then proceed with the
installation of V7.1.0.

What to do next

[“Updating the application server and the databases” on page 3-1|

Running Installation Manager in command-line mode

Procedure

1. For a silent installation, use the install-no-appcenter.xml file that is listed in
[Working with sample response files for IBM Installation Manager]

2. Make a copy of the file you selected.
3. Open the copied XML file with a text editor or XML editor. Modify the
following elements:
a. The repository element that defines the repository list.
Create a repository entry for the repository of IBM MobileFirst Platform
Foundation for iOS V7.1.0 and also the repository of the fix pack that you

plan to upgrade. The fix packs are delivered as delta installers and cannot
be installed if the base version is not among the listed repositories.

If you decompress the base installer in 710_installer_directory folder, the
repository file to enter is 710_installer_directory/
MobileFirst_Platform_Server/diskl/diskTag.inf. If you decompress the
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interim fix file in ifix_directory folder, the repository file to enter is
ifix_directory/MobileFirst Platform Server/diskl/diskTag.inf.

b. Uncomment the line <data key='user.licensed.by.tokens'
value='false'/>. Set the value to true if you have a contract to use token
licensing with the Rational License Key Server. Otherwise, set the value to
false.

If you activate token licensing, make sure that the Rational License Key
Server is configured, and enough tokens can be obtained to run MobileFirst
Server and the applications it serves. Otherwise, the MobileFirst Server
administration application and the runtime environment cannot be run.

Restriction: After the decision is made to activate token licensing or not, it
cannot be modified. If you run an upgrade with the value true, and later
another upgrade with the value false, the second upgrade fails.

€. Review the profile identity and the installation location. Make sure that the
profile identity and the installation location do not collide with another
installation on your computer.

e This line: <profile id="IBM MobileFirst Platform Server'
installLocation="'/opt/IBM/MobileFirst_Platform_Server'>

* And this line: <offering id='com.ibm.mobilefirst.foundation.server'
version='7.1.0.00-20150913-2345" profile="IBM MobileFirst Platform
Server' features='main.feature' installFixes='none'/>

* To review the profile identity and the installation directories that are
known to Installation Manager, you can type the command:

installation_manager_path/eclipse/tools/imc1 listInstallationDirectories -verbose
4. Open a session with the user account that is used at the initial installation.

To apply an update, Installation Manager must run with the same list of
registry files that are used at the initial installation. The list of Software that is
installed and the options that are used during the installation time are stored in
those registry files. If you run Installation Manager in administrator mode, the
registry files are installed at the system level. In /var folder on UNIX or Linux.
In c:\ProgramData folder on Windows. The location is independent from the
user who runs Installation Manager (although root is needed on UNIX and
Linux). However, if you run Installation Manager in single user mode, the
registry files are stored by default in the user's home directory.

5. Run the command installation_manager path/eclipse/tools/imcl input
<responseFile> -log /tmp/installwl.log -acceptLicense

Where
* <responsefile>is the XML file that you edit in

* -Tog /tmp/installwl.log is optional. It specifies a log file for the output of
Installation Manager.

* -acceptlicense is mandatory. It means that you accept the license terms of
IBM MobileFirst Platform Foundation for iOS V7.1.0. Without that option,
Installation Manager cannot proceed with the update.

What to do next

[“Updating the application server and the databases” on page 3-1|
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Updating the application server and the databases

About this task

IBM MobileFirst Platform Foundation for iOS provides several components that
you might have installed. Here is a description of their dependencies to update

them:

MobileFirst Server Administration Service, MobileFirst Operations Console, and
MobileFirst runtime environment

These three components compose as MobileFirst Server and replace the
unique V5.0.6 project WAR file. Make sure that you install and configure
the Administration Service and MobileFirst Operations Console with a
topology that is supported in the list at [Planning deployment of|

ladministration components and runtimes]

Although the runtime environment is provided by your development team
and built with MobileFirst Platform Command Line Interface for iOS (CLI),
it is not necessary to recompile the project and applications with CLI
V7.1.0 when you upgrade your server to V7.1.0. It is possible to separate
these lifecycles. However, you need to migrate the project WAR file to
make it compatible with V7.1.0. The following instructions include the step
to migrate the project WAR file so that it is binary compatible with V7.1.0.

You can continue to upload the applications and adapters that are built
with V5.0.6 to that runtime environment after you migrate the server to
V7.1.0. However, do not upload the applications and adapters that are built
with V7.1.0. For more information, see [Version compatibilityl]

To deploy the applications that are built with V7.1.0, you have the
following two choices.

¢ Add a MobileFirst runtime environment with its own database. Do not
share the database between different runtimes.

* Replace the deployed runtime environment by a runtime environment
that is built with V7.1.0, at the condition that its configuration is
compatible with the applications that are built with V5.0.6. For example,
a session-independent configuration would not be compatible with the
applications that are developed with V5.0.6. For V7.0.0 or earlier, the
runtime application is configured for session-dependent mode by
default.

Application Center

The installation of this component is optional. This component is
independent of the other components. It can be run at a different interim
fix level than the others if needed.

MobileFirst Operational Analytics

© Copyright IBM Corp. 2015, 2016
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Installing MobileFirst Server Administration Service, MobileFirst
Operations Console, and MobileFirst runtime environment

About this task

You can update these components in two ways:
* With the Server Configuration Tool

* With Ant tasks

* Manually

Important:
* Upgrade the database by a database administrator:

In some cases, you might want to upgrade the databases manually. For example,
to set some non-default properties to the new tables created. When you run an
upgrade with Server Configuration Tool, it looks at the value in the tables (such
as WORKLIGHT VERSION for a runtime database) and detects that the tables are
already upgraded to V7.1.0. Thus, the tool would not attempt to upgrade them.
When you use Ant tasks, do not run the database and admdatabases targets if
the databases are already updated manually. If you do run them, the Ant tasks
would detect that the schema is in V7.1.0.

* WebSphere Application Server specifics:

— The user that runs the upgrade needs to have at least the privileges of a
Configurator role to install new application. In some cases if a user needs to
be created, or the application security needs to be activated, an Administrator
role is required.

— The order of operations is important. Make sure that you follow the sequence
that is described in the following sections to update the MobileFirst Server
Administration component first. Then, the runtime environments. If the
runtime environments fail to synchronize with the MobileFirst Server
Administration (such as JMX binary incompatibility that is introduced in the
fix pack), they would fail to start.

— If your application server is WebSphere Application Server V7.0, you must
add the configuration property
com.ibm.ws.webcontainer.invokerequestlistenerforfilter = true. For more
information about how to add this property, see [Configuring WebSphere|
[Application Server V7.0l This setting is required for the runtime environment
(the Project WAR File) in V7.1.0.

 All application servers must be stopped. All procedures in the following tasks
assume that the application servers running the Worklight applications are
stopped until the upgrade of all components is complete.

Upgrading the databases
About this task

This task is optional if you upgrade with the Server Configuration Tool. The
upgrade of the database does the following things:

1. Create a set of new tables for the Administration Service.

2. Copy some of the data in the Worklight runtime database to the Administration
Service database. The data is related to the artifacts (such as the apps and the
adapters) that you can manage from MobileFirst Operations Console.
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3. Upgrade the content of the Worklight runtime database to V7.1.0. This
operation includes removing the data that is transferred to the Administration
database, and converting the data that is related to the push notification to a
new data model.

Important: Back up the databases for the Worklight runtime environment. The
migration scripts delete some data in your database and the operation cannot be
undone. If you decide to roll back the upgrade of MobileFirst Server, you need this
backup.

Upgrading the databases with Ant tasks
Run the admdatabases target to create the WorklightAdmin. Then, run the databases
target to migrate and upgrade the Worklight database.

Before you begin

You need the following privileges to run the Ant tasks:

* CREATE INDEX, CREATE SEQUENCE, CREATE TABLE, CREATE VIEW, REPLACE VIEW,
SELECT, DELETE, INSERT, UPDATE, MERGE, DROP VIEW, DROP TABLE, DROP INDEX, DROP
SEQUENCE, and ALTER TABLE

The upgrade scripts not only modify the table structure, but also run a data
conversion for the push data. You need the privileges such as CREATE VIEW and
DROP VIEW that are not required in previous upgrade path. If the DB user is not
created by the installation of V6.1.0 or earlier, or it is modified since the creation,
verify that you have enough privileges to run the scripts.

Procedure

1. Create an Ant file from the model of the configuration samples that are
provided in product_install_dir/WorklightServer/configuration-samples
folder.

If you plan to create the tables in a database that exists and also use an existing
user, use the file that is named as configure-<appserver>-<dbtype>.xml.

If you plan to create tables in a database that does not exist, or with a user that
does not exist, use the file that is named as create-database-<dbtype>.xml.
These files require database administrator credentials to run the operations to
create tables and user. When you run the admdatabases target, the Ant tasks
might need to open an ssh session to the server that runs the database.

You can also find the redeploy506-<appserver>-<dbtype>.xml files in
product_install _dir/WorklightServer/configuration-samples folder. These
files are similar to the configure-<appserver>-<dbtype>.xml files except that
they contain some database values that are set by the installer for V5.0.6. You
can use these files if the database settings are not modified after V5.0.6 is
installed.

Note: Make sure that you verify the parameters you use are the same as the
one you use at the initial installation time. Verify the parameter details such as
the server name, the cluster name, the database, the users, and the schemas. If
the database parameters are different than the ones that are used at the initial
installation, the Ant task might create new empty tables instead of upgrading
the tables to the new format. If the application servers parameters are not the
same as the ones that used at the initial installation, the Ant task might fail to
update the application.

2. Run the admdatabases target to create the WorklightAdmin database and tables.
For example,
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product_install_dir/shortcuts/ant -f your ant file.xml admdatabases

3. Run the databases target to migrate and upgrade the Worklight databases. For
example,

product_install_dir/shortcuts/ant -f your_ant_file.xml databases

The target migrates the administration-related content of the Worklight
database to the Administration Service database. Then, it deletes the migrated
content, converts the data that is related to push notification to the new data
structure, and upgrades the tables to the V7.1.0 schema.

Note: You need to run this step El on each runtime environment if you have
more than one runtime environment.

4. If you use push notification, you must complete some additional manual
configuration.

This task requires the use of a database account that can modify the content of
the runtime database. It also requires basic knowledge to run SQL scripts on
the database. For DB2®, you need to know how to run the DB2 command line
processor or the command line program. For Oracle, make sure that you know
how to run SQLPlus. This task is only needed for Oracle or DB2. It is not
needed for MySQL.

DB2
a. Change SCHEMANAME instances to actual names.

b. Replace X and Y values based on the given description.

SELECT MAX(ID) FROM SCHEMANAME.PUSH_DEVICES;
SELECT MAX(ID) FROM SCHEMANAME.PUSH_SUBSCRIPTIONS;

--Value of X = Result of the selected query of PUSH_DEVICES + 1. For example, if SELECT MAX(ID) FROM
--SCHEMANAME .PUSH_DEVICES returns 100, then X = 101;

--Value of Y = Result of the selected query of PUSH_SUBSCRIPTIONS + 1. For example, if SELECT MAX(ID) FROM
--SCHEMANAME .PUSH_SUBSCRIPTIONS returns 100, then Y = 101;

ALTER SEQUENCE SCHEMANAME .PUSHDEVICE_SEQ RESTART WITH X ;
ALTER SEQUENCE SCHEMANAME .PUSHSUBSCRIPTION_SEQ RESTART WITH Y

VALUES NEXT VALUE FOR SCHEMANAME .PUSHDEVICE_SEQ;
VALUES NEXT VALUE FOR SCHEMANAME .PUSHSUBSCRIPTION_SEQ;

Oracle
a. Change SCHEMANAME instances to actual names.
b. Replace X and Y values (based on the given description) while
running the query.

SELECT MAX(ID) FROM SCHEMANAME .PUSH_DEVICES;
SELECT MAX(ID) FROM SCHEMANAME .PUSH_SUBSCRIPTIONS;

SELECT LAST_NUMBER FROM ALL_SEQUENCES WHERE SEQUENCE_NAME='PUSHDEVICE_SEQ';
SELECT LAST_NUMBER FROM ALL_SEQUENCES WHERE SEQUENCE_NAME='PUSHSUBSCRIPTION_SEQ';

--Take note of the resulting value of each query above to use in the following X and Y calculations

--Value of X = (MAX(ID) OF PUSH_DEVICES - LAST NUMBER OF PUSHDEVICE_SEQ) + 20. For example, if SELECT MAX(ID) FROM
--SCHEMANAME .PUSH_DEVICES returned 100 and SELECT LAST_NUMBER FROM ALL_SEQUENCES
--(where SEQUENCE_NAME='PUSHDEVICE_SEQ' is 50), then X=100-50+20 = 70

--Value of Y = (MAX(ID) OF PUSH_SUBSCRIPTIONS - LAST_NUMBER OF PUSHSUBSCRIPTION_SEQ) + 20. For example, if SELECT
--MAX(ID) FROM SCHEMANAME.PUSH_SUBSCRIPTIONS returned 100, then Y = 101 and SELECT --LAST_NUMBER
--FROM ALL_SEQUENCES (where SEQUENCE_NAME='PUSHSUBSCRIPTION_SEQ' is 50), then Y=100-50+20 = 70

ALTER SEQUENCE SCHEMANAME.PUSHDEVICE _SEQ INCREMENT BY X ;
SELECT SCHEMANAME.PUSHDEVICE _SEQ.NEXTVAL FROM dual;
ALTER SEQUENCE SCHEMANAME.PUSHDEVICE SEQ INCREMENT BY 1;
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ALTER SEQUENCE SCHEMANAME.PUSHSUBSCRIPTION_SEQ INCREMENT BY Y ;
SELECT SCHEMANAME . PUSHSUBSCRIPTION_SEQ.NEXTVAL FROM dual;
ALTER SEQUENCE SCHEMANAME.PUSHSUBSCRIPTION_SEQ INCREMENT BY 1;

MySQL

No action is required.

Upgrading the databases manually
The upgrade and database creation scripts are in product_install_dir/
WorklightServer/databases.

Procedure

1.

Create the administration database.

* For DB2, see [Setting up your DB2 database manually for the MobileFirst|

[Server administration]

+ For MySQL, see [Setting up your MySQL database manually for the]

[MobileFirst Server administration|

+ For Oracle, see [Setting up your Oracle database manually for the MobileFirst|

[Server administration]

2. Select the script, depending on your database, to upgrade the Runtime

databases.
a. Upgrade the database from V5.0.6 to V6.0.0 by using one of the following

scripts:

* upgrade-worklight-506-60-db2.sql

* upgrade-worklight-506-60-mysql.sql

* upgrade-worklight-506-60-oracle.sql

Then, upgrade the database from V6.0.0 to V6.1.0.
* upgrade-worklight-60-61-db2.sql

* upgrade-worklight-60-61-mysql.sql

* upgrade-worklight-60-61-oracle.sql

. Use the data migration tool to migrate the content that is related to the

administration from the Worklight Runtime database to the administration
database.

When you upgrade from IBM Worklight V6.1.0 or older, before you call the
script WorklightServer/databases/upgrade-worklight-61-62-<dbms>.sql,
run the data migration tool to migrate the administration database to the
new administration database. Then, run the SQL scripts from V6.2.0 to the
current release to update the WRKLGHT database schema. If you forgot to run
the data migration tool before you run the SQL script, WorklightServer/
databases/upgrade-worklight-61-62-<dbms>.sql is likely to fail, and
indicates that the data migration was not run. In that case, the WRKLGHT
schema is not updated, or the production data might be corrupted or lost.

The data migration tool is included in the product_install_dir/
WorklightServer/worklight-ant-deployer.jar file.

Before you run the tool in command-line, make sure that the library
worklight-ant-deployer.jar of the MobileFirst version that you installed is
in your current directory, or that your CLASSPATH variable references the
directory it is in. An example on a Unix/Linux machine:

# Go to the directory library that worklight-ant-deployer.jar is in
$ cd $product_install_dir/WorklightServer

# Print the usage

$ java -cp worklight-ant-deployer.jar com.ibm.worklight.config.dbmigration.MigrationTool usage
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Usage:
java -cp worklight-ant-deployer.jar com.ibm.worklight.config.dbmigration.MigrationTool [options]

Options:
-p <project> The name of the project to create.
-sourceurl The path to the source database.
-sourceschema The name of the schema of the source database.
-sourcedriver The fully qualified driver class name of the source
database. This driver must be in the class path.
-sourceuser The user name of the source database.

-sourcepassword The password of the source database.
-sourceproperty <key> <value> Adds additional OpenJPA properties to the connection
of the source database.

-targeturl The path to the target database.

-targetschema The name of the schema of the target database.

-targetdriver The fully qualified driver class name of the target
database. This driver must be in the class path.

-targetuser The user name of the target database.

-targetpassword The password of the target database.
-targetproperty <key> <value> Adds additional OpenJPA properties to the connection
of the target database.

# Example with DB2 as DBMS
$ java -cp worklight-ant-deployer.jar com.ibm.worklight.config.dbmigration.MigrationTool
-p worklight
-sourceurl jdbc:db2://proddb.example.com:50000/WRKLGHT
-sourceschema WLRT
-sourcedriver com.ibm.db2.jcc.DB2Driver
-sourceuser wluserl
-sourcepassword wluserl_pswd
-targeturl jdbc:db2://proddb.example.com:50000/WLADMIN
-targetschema ADMIN
-targetdriver com.ibm.db2.jcc.DB2Driver
-targetuser wluser2
-targetpassword wluser2_pswd
To run the data migration tool, you must add the database drivers to the
class path. For example, to migrate a DB2 database, you must add the
db2jcc4. jar file and the license JAR file (for example
db2jcc_license_cu.jar), to the class path:
$ java -cp worklight-ant-deployer.jar:/path/to/db2jcc4.jar:/path/to/db2jcc_license cu.jar
com.ibm.worklight.config.dbmigration.MigrationTool usage

Note:

* The name of the project to create (worklight in the example) must be the
context root where the MobileFirst runtime component (project WAR file)
is deployed. For example, if the runtime component is deployed in the
application server with a context root /worklight, then the project name
must be worklight. The applications will be assigned to this project name.
When a runtime component starts, it contacts the administration service
to get the applications and the adapters it needs to serve. The runtime
component uses its project name, computed by removing the initial /
from its context root, to indicate which applications it needs. If the project
name is not the same as the context root without the initial slash, then the
migrated applications and the adapters are not visible by the runtime
component.

* For MySQL databases, the schema options '-sourceschema' and
'-targetschema' must be left unspecified. The name of the schema to use
will be the name of the database specified in the connection URL.

d. Upgrade the database from V6.1.0 to V6.2.0.
* upgrade-worklight-61-62-db2.sql
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* upgrade-worklight-61-62-mysql.sq]l
* upgrade-worklight-61-62-oracle.sql
e. Upgrade the database from V6.2.0 to V6.3.0.
* upgrade-worklight-62-63-db2.sql
* upgrade-worklight-62-63-mysql.sql
* upgrade-worklight-62-63-oracle.sql
f. Upgrade the database from V6.3.0 to V7.0.0.
* upgrade-worklight-63-70-db2.sql
* upgrade-worklight-63-70-mysql.sql
* upgrade-worklight-63-70-oracle.sql
g. Lastly, upgrade the database from V7.0.0 to V7.1.0.
* upgrade-worklight-70-71-db2.sq]l
* upgrade-worklight-70-71-mysql.sq]l
* upgrade-worklight-70-71-oracle.sql

Note: If several runtime environments (also know as the project WAR files) are
installed, you have several instances of that database, one per runtime
environment.

. The reports database is deprecated in V7.1.0. However, if you still plan to use
them, select the script, depending on your database, to upgrade the Reports
database for the runtime environment.

a. Upgrade the database from V6.0.0 to V6.1.0 by using one of the following
scripts:

* upgrade-worklightreports-60-61-db2.sq]l

* upgrade-worklightreports-60-61-mysql.sql

* upgrade-worklightreports-60-61-oracle.sql
b. Upgrade the database from V6.1.0 to V6.2.0.

* upgrade-worklightreports-61-62-db2.sql

* upgrade-worklightreports-61-62-mysql.sql

* upgrade-worklightreports-61-62-oracle.sql
c. Upgrade the database from V6.2.0 to V6.3.0.

* upgrade-worklightreports-62-63-db2.sql

* upgrade-worklightreports-62-63-mysql.sql

* upgrade-worklightreports-62-63-oracle.sql
d. Upgrade the database from V6.3.0 to V7.0.0.

* upgrade-worklightreports-63-70-db2.sq]l

* upgrade-worklightreports-63-70-mysql.sql

* upgrade-worklightreports-63-70-oracle.sql
e. Lastly, upgrade the database from V7.0.0 to V7.1.0.

* upgrade-worklightreports-70-71-db2.sq]l

* upgrade-worklightreports-70-71-mysql.sql

* upgrade-worklightreports-70-71-oracle.sql

Note: If you are not using the reports feature, do not upgrade the databases.

Make sure that your applications do not export data to the reports database by
setting the value of the JNDI property (reports.exportRawData) to false.
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4. If you use push notification, you must complete some additional manual
configuration.
DB2
a. Change SCHEMANAME instances to actual names.
b. Replace X and Y values based on the given description.
SELECT MAX(ID) FROM SCHEMANAME .PUSH_DEVICES;
SELECT MAX(ID) FROM SCHEMANAME .PUSH_SUBSCRIPTIONS;

--Value of X = Result of the selected query of PUSH_DEVICES + 1. For example, if SELECT MAX(ID) FROM
--SCHEMANAME .PUSH_DEVICES returns 100, then X = 101;

--Value of Y = Result of the selected query of PUSH_SUBSCRIPTIONS + 1. For example, if SELECT MAX(ID) FROM
--SCHEMANAME .PUSH_SUBSCRIPTIONS returns 100, then Y = 101;

ALTER SEQUENCE SCHEMANAME .PUSHDEVICE_SEQ RESTART WITH X ;
ALTER SEQUENCE SCHEMANAME .PUSHSUBSCRIPTION_SEQ RESTART WITH Y ;

VALUES NEXT VALUE FOR SCHEMANAME .PUSHDEVICE_SEQ;
VALUES NEXT VALUE FOR SCHEMANAME .PUSHSUBSCRIPTION_SEQ;

Oracle
a. Change SCHEMANAME instances to actual names.

b. Replace X and Y values (based on the given description) while
running the query.
SELECT MAX(ID) FROM SCHEMANAME.PUSH_DEVICES;
SELECT MAX(ID) FROM SCHEMANAME .PUSH_SUBSCRIPTIONS;

SELECT LAST_NUMBER FROM ALL_SEQUENCES WHERE SEQUENCE_NAME='PUSHDEVICE_SEQ';
SELECT LAST_NUMBER FROM ALL_SEQUENCES WHERE SEQUENCE_NAME='PUSHSUBSCRIPTION_SEQ';

--Take note of the resulting value of each query above to use in the following X and Y calculations

--Value of X = (MAX(ID) OF PUSH_DEVICES - LAST NUMBER OF PUSHDEVICE_SEQ) + 20. For example, if SELECT MAX(ID) FROM
--SCHEMANAME .PUSH_DEVICES returned 100 and SELECT LAST_NUMBER FROM ALL_SEQUENCES
--(where SEQUENCE_NAME='PUSHDEVICE_SEQ' is 50), then X=100-50+20 = 70

--Value of Y = (MAX(ID) OF PUSH_SUBSCRIPTIONS - LAST_NUMBER OF PUSHSUBSCRIPTION_SEQ) + 20. For example, if SELECT
--MAX(ID) FROM SCHEMANAME.PUSH_SUBSCRIPTIONS returned 100, then Y = 101 and SELECT --LAST_NUMBER
--FROM ALL_SEQUENCES (where SEQUENCE_NAME='PUSHSUBSCRIPTION_SEQ' is 50), then Y=100-50+20 = 70

ALTER SEQUENCE SCHEMANAME.PUSHDEVICE_SEQ INCREMENT BY X ;
SELECT SCHEMANAME.PUSHDEVICE SEQ.NEXTVAL FROM dual;
ALTER SEQUENCE SCHEMANAME.PUSHDEVICE _SEQ INCREMENT BY 1;

ALTER SEQUENCE SCHEMANAME.PUSHSUBSCRIPTION_SEQ INCREMENT BY Y ;
SELECT SCHEMANAME.PUSHSUBSCRIPTION_SEQ.NEXTVAL FROM dual;
ALTER SEQUENCE SCHEMANAME.PUSHSUBSCRIPTION_SEQ INCREMENT BY 1;

MySQL

No action is required.

Installing the MobileFirst Server Administration Service,
MobileFirst Operations Console, and upgrading the
MobileFirst runtime environment

About this task

The runtime environment that is referred by this procedure is the project WAR file.
This WAR file is provided by your development team and built with MobileFirst
Platform Command Line Interface for iOS (CLI). It is not necessary to recompile
the project and applications with CLI V7.1.0 when you upgrade your server to
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V7.1.0. It is possible to separate these lifecycles. However, you need to migrate the
project WAR file to make it compatible with V7.1.0. The following instructions
include the step to migrate the project WAR file so that it is binary compatible
with V7.1.0.

You can continue to upload the applications and adapters that are built with V5.0.6
to that runtime environment after you migrate the server to V7.1.0. However, do
not upload the applications and adapters that are built with V7.1.0. For more
information, see [Version compatibility]

To deploy the applications that are built with V7.1.0, you have the following two
choices.

¢ Add a MobileFirst runtime environment with its own database. Do not share the
database between different runtimes.

* Replace the deployed runtime environment by a runtime environment that is
built with V7.1.0, at the condition that its configuration is compatible with the
applications that are built with V5.0.6. For example, a session-independent
configuration would not be compatible with the applications that are developed
with V5.0.6. For V7.0.0 or earlier, the runtime application is configured for
session-dependent mode by default.

Installing with the Server Configuration Tool
Before you begin

The database user for the WORKLIGHT database needs the following privileges to
perform the upgrade:

* CREATE INDEX, CREATE SEQUENCE, CREATE TABLE, CREATE VIEW, REPLACE VIEW,
SELECT, DELETE, INSERT, UPDATE, MERGE, DROP VIEW, DROP TABLE, DROP INDEX, DROP
SEQUENCE, and ALTER TABLE

The upgrade scripts not only modify the table structure, but also run a data
conversion for the push data. You need the privileges such as CREATE VIEW and
DROP VIEW that are not required in previous upgrade path. If the DB user is not
created by the installation of V6.1.0 or earlier, or it is modified since the creation,
verify that you have enough privileges to run the scripts.

About this task

This procedure upgrades the databases as well if it is not manually done before.
The Server Configuration Tool looks at the value in the XXX_VERSION table. For
example, WORKLIGHT_VERSION for a runtime database.

Important: Back up the databases for the Worklight runtime environments. The
migration scripts delete some data in your database and the operation cannot be
undone. If you decide to roll back the upgrade of MobileFirst Server, you need this
backup.

Procedure
1. Start the Server Configuration Tool from the V7.1.0 product installation.

To verify that the Server Configuration Tool runs the version that you want to
upgrade to, open the menu Help > About the Server Configuration Tool. A
dialog appears with the build number. It must match the version that you
install with Installation Manager. For example, make sure that the build
number of the Server Configuration Tool is 7.1.0.00.20151005-1721 if V7.1.0
and the interim fix 7.1.0.0-1F201510051721 are installed.
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10.

11.
12.

13.

14.

15.

Select File > New Configuration.
Enter a name for the configuration. For example, MFP Install.

In the Database Selection Panel, select the database that contains your V5.0.6
data.

In the Database Settings Panel, enter the settings for the database that
contains your V5.0.6 data.

In the Database Additional Settings panel, enter the schema or database
name for the administration database.

If the tables are created by a database administrator (DBA) earlier, make sure
that you give the same settings as the one used by the DBA. Otherwise, the
Server Configuration Tool creates new tables somewhere else.

In the Application Server Settings panel, enter the settings of the application
server where you want to deploy V7.1.0.

In the Analytics Settings panel, keep the Enable the connection to the
Analytics Server option cleared. If you later install MobileFirst Operational
Analytics, you can enable the connection by setting some JNDI properties.

Click Deploy.
This step deploys the Administration Service and MobileFirst Operations

Console to your application server. It creates the tables in the administration
database if needed.

Select your configuration in the left view and click File > Add MobileFirst
Runtime Environment....

Enter a name for this runtime environment.

Enter your project WAR File. It can be the V5.0.6 project WAR file. The Server
Configuration Tool will migrate it to be compatible with V7.1.0.

In the Database Additional Settings panel, enter the schema or the database
that contains your V5.0.6 data.

Click Deploy.

It is not needed to enter anything in the Database creation request panel. If
you need to, this means the database parameters that you have entered
correspond to a database that does not exist or cannot be accessed by the user
you provided.

The Server Configuration Tool migrates the runtime database to the
administration database (if not done earlier), and upgrades it to V7.1.0. It then
deploys the project WAR file to the application server.

If you use push notification, you must complete some additional manual
configuration.

This task requires the use of a database account that can modify the content of
the runtime database. It also requires basic knowledge to run SQL scripts on
the database. For DB2, you need to know how to run the DB2 command line
processor or the command line program. For Oracle, make sure that you know
how to run SQLPlus. This task is only needed for Oracle or DB2. It is not
needed for MySQL.

DB2
a. Change SCHEMANAME instances to actual names.
b. Replace X and Y values based on the given description.

SELECT MAX(ID) FROM SCHEMANAME.PUSH_DEVICES;
SELECT MAX(ID) FROM SCHEMANAME.PUSH_SUBSCRIPTIONS;

--Value of X = Result of the selected query of PUSH_DEVICES + 1. For example, if SELECT MAX(ID) FROM
--SCHEMANAME .PUSH_DEVICES returns 100, then X = 101;
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--Value of Y = Result of the selected query of PUSH_SUBSCRIPTIONS + 1. For example, if SELECT MAX(ID) FROM
--SCHEMANAME .PUSH_SUBSCRIPTIONS returns 100, then Y = 101;

ALTER SEQUENCE SCHEMANAME .PUSHDEVICE_SEQ RESTART WITH X ;
ALTER SEQUENCE SCHEMANAME .PUSHSUBSCRIPTION_SEQ RESTART WITH Y ;

VALUES NEXT VALUE FOR SCHEMANAME .PUSHDEVICE_SEQ;
VALUES NEXT VALUE FOR SCHEMANAME .PUSHSUBSCRIPTION_SEQ;

Oracle
a. Change SCHEMANAME instances to actual names.
b. Replace X and Y values (based on the given description) while
running the query.

SELECT MAX(ID) FROM SCHEMANAME .PUSH_DEVICES;
SELECT MAX(ID) FROM SCHEMANAME.PUSH_SUBSCRIPTIONS;

SELECT LAST_NUMBER FROM ALL_SEQUENCES WHERE SEQUENCE_NAME='PUSHDEVICE_SEQ';
SELECT LAST NUMBER FROM ALL_SEQUENCES WHERE SEQUENCE_NAME='PUSHSUBSCRIPTION_SEQ';

--Take note of the resulting value of each query above to use in the following X and Y calculations

--Value of X = (MAX(ID) OF PUSH_DEVICES - LAST NUMBER OF PUSHDEVICE_SEQ) + 20. For example, if SELECT MAX(ID) FROM
--SCHEMANAME .PUSH_DEVICES returned 100 and SELECT LAST_NUMBER FROM ALL _SEQUENCES
--(where SEQUENCE NAME='PUSHDEVICE_SEQ' is 50), then X=100-50+20 =

--Value of Y = (MAX(ID) OF PUSH_SUBSCRIPTIONS - LAST_NUMBER OF PUSHSUBSCRIPTION_SEQ) + 20. For example, if SELECT
--MAX(ID) FROM SCHEMANAME.PUSH_SUBSCRIPTIONS returned 100, then Y = 101 and SELECT --LAST_NUMBER
--FROM ALL_SEQUENCES (where SEQUENCE_NAME='PUSHSUBSCRIPTION_SEQ' is 50), then Y=100-50+20 = 70

ALTER SEQUENCE SCHEMANAME.PUSHDEVICE _SEQ INCREMENT BY X ;
SELECT SCHEMANAME.PUSHDEVICE_SEQ.NEXTVAL FROM dual;
ALTER SEQUENCE SCHEMANAME.PUSHDEVICE_SEQ INCREMENT BY 1;

ALTER SEQUENCE SCHEMANAME.PUSHSUBSCRIPTION_SEQ INCREMENT BY Y ;
SELECT SCHEMANAME . PUSHSUBSCRIPTION_SEQ.NEXTVAL FROM dual;
ALTER SEQUENCE SCHEMANAME.PUSHSUBSCRIPTION_SEQ INCREMENT BY 1;

MySQL

No action is required.

16. Optional: If you have a reverse proxy and all network traffic in your data
center go through that proxy, you must configure the endpoints. For more
information, see [Defining the endpoint of the MobileFirst Administration|

Upgrading with Ant tasks
Before you begin

You must upgrade the databases before you run this procedure. For more
information, see [“Upgrading the databases” on page 3-2.|

About this task
Run the adminstall target to install the Administration Service WAR file. Then, run

the install target to update the runtime WAR file and the worklight-jee-
Tibrary.jar library. Restart the application server for these updates to take effect.
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Procedure

1. If you upgrade the databases with Ant tasks and use an Ant file such as
configure-<appserver>-<dbtype>.xml or redeploy506-<appserver>-
<dbtype>.xml, you can reuse this Ant file for this upgrade task. Otherwise, read
the following steps to create an Ant file:

a. Create an Ant file from the model of the configuration samples that are
provided in product_install_dir/WorklightServer/configuration-samples
folder.

Use the file that is named as configure-<appserver>-<dbtype>.xml.

You can also find the redeploy506-<appserver>-<dbtype>.xml files in
product_install _dir/WorklightServer/configuration-samples folder. These
files are similar to the configure-<appserver>-<dbtype>.xml files except that
they contain some database values that are set by the installer for V5.0.6.
You can use these files if the database settings are not modified after V5.0.6
is installed.

Note: Make sure that you verify the parameters you use are the same as
the one you use at the initial installation time. Verify the parameter details
such as the server name, the cluster name, the database, the users, and the
schemas. If the database parameters are different than the ones that are
used at the initial installation, the Ant task might create new empty tables
instead of upgrading the tables to the new format. If the application servers
parameters are not the same as the ones that used at the initial installation,
the Ant task might fail to update the application.

b. Verify the path of the project WAR File (the runtime path).

If the path is not to the most current project WAR file that is deployed to
the application server, update the path. This WAR file is to be migrated (to
be binary compatible with the worklight-jee-Tlibrary.jar of the fix pack or
interim fix) and redeployed to the application server. The base name of the
project WAR file must be the same as the one that is previously installed.

c. Optional: Follow the instructions that are described in [Manually creating]
land configuring the reports database|if you plan to use the deprecated
WorklightReports feature after you complete the upgrade with Ant tasks.
Manual configuration is needed because the Ant files in
product_install_dir/WorklightServer/configuration-samples do not
install the Worklight Reports database by default.

2. Run the adminstall target to install the MobileFirst Server Administration
Service and MobileFirst Operations Console WAR files. For example,

product_install_dir/shortcuts/ant -f your ant file.xml adminstall

3. Run the install target to update each MobileFirst runtime environment. For
example,

product_install_dir/shortcuts/ant -f your_ant_file.xml install

This install target makes a copy of the project WAR file that is specified in the
worklight.project.war.file property and migrates the copy so that it is binary
compatible with the newworklight-jee-Tibrary.jar library. The install target
installs this copy of the WAR file into the application server and updates the
worklight-jee-Tibrary.jar library.

4. Configure the user authentication for MobileFirst Server administration as
described in |[Configuring user authentication for MobileFirst Server|

|administratiogl
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5. If you have a reverse proxy and all network traffic in your data center go
through that proxy, you must configure the endpoints. For more information,
see [Defining the endpoint of the MobileFirst Administration services|

6. Repeat this operation for all the servers of a farm.

Upgrading manually
Before you begin

You must upgrade the databases before you run this procedure. See
[the databases” on page 3-2.|

Procedure

1. Install the MobileFirst Server Administration Service and MobileFirst
Oi erations Console as described at [Manually installing MobileFirst Server|

administratio

Note: Skip the "Setting up your XXX database manually for the MobileFirst
Server administration" operation that is under the "Configuring the XXX
database manually for the IBM MobileFirst Platform Server administration"
topic. This operation is done earlier when you upgrade the databases.

2. Locate the WAR and JAR files. The new versions of these files that you need to
update are in product_install_dir/WorklightServer folder.

3. Replace the worklight-jee-library.jar library.

4. Migrate the project WAR file (MobileFirst runtime WAR file) so that it is binary
compatible with the upgraded worklight-jee-Tlibrary.jar library.
a. Find the most current version of the project WAR file that is published by

your development team.

b. Migrate the project WAR file as described in [Migrating a project WAR file|
[for use with a new MobileFirst Server

5. Install the migrated project WAR file to your application server. For more

information, see [Deploying a project WAR file and configuring the application|

lserver manually]

6. On WebSphere Application Server Network Deployment, do a full
synchronization of the servers.

Configuring your server farm
You must perform this task regardless you install the applications manually, with
Server Configuration Tool, or with Ant tasks.

You need to update the configuration if you configure a server farm to run IBM
MobileFirst Platform Foundation for iOS in V5.0.6.

In V7.1.0, the servers of a cluster, if they are not running on a WebSphere
Application Server Network Deployment cluster, need to be federated as a server
farm. In this case, any administration change, such as uploading a new version of
an adapter, can be reflected to all the servers of the runtime environment.

The high-level procedure to configure the server farm is as follows:

1. Declare some JNDI properties in MobileFirst Server Administration Service to
declare the farm topology and other information to enable the other farm
members to contact it via JMX. The information is then shared via the
administration database.
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farm node|

2. For WebSphere Application Server Liberty profile and WebSphere Application
Server, the authentication to stateless applications such as MobileFirst

Operations Console uses LTPA tokens, you must ensure that all servers have
the same LTPA keys.

For more information about the configuration, see [Configuring a server farm|

To verify the farm configuration, you can look at the Server Farm Nodes tab in
MobileFirst Operations Console. For more information, see [Lifecycle of a server]

Special configurations
Procedure

1. If Activate Token Licensing is selected when you run Installation Manager to
upgrade the product installation to V7.1.0, you need to [configure your server|
[for token licensing] Select Activate Token Licensing only if you have a
contract to use token licensing.

2. If your application server is WebSphere Application Server V7.0, you must add
the configuration property
com.ibm.ws.webcontainer.invokerequestlistenerforfilter = true. For more
information about how to add this property, see [Configuring WebSphere|
[Application Server V7.0l This setting is needed for the runtime environment
(the Project WAR File) in V7.1.0.

Updating your deployment scripts

In V7.1.0, the app-deployer and adapter-deployer Ant tasks no longer exist. The
apps and adapters cannot be deployed with these Ant tasks. Use wladm in
command-line, or as Ant tasks. For more information, see the following topics:

* |Administering MobileFirst applications through Ant]

* |Administering MobileFirst applications through the command line|
+ [REST API Administration Services|

Upgrading Application Center

About this task

You can update this component in two ways:
* With Ant tasks
* Manually

It is not required to upgrade Application Center if you install with Installation
Manager.

Important:
* Upgrade the database by a database administrator:

In some cases, you might want to upgrade the databases manually. For example,
to set some non-default properties to the new tables created. This is not possible
if you upgrade Application Center with Installation Manager since the database
scripts are only available after you run Installation Manager. However, if you
upgrade the Application Center manually before you run Installation Manager, it
would detect that the tables are upgraded to V7.1.0. Installation Manager looks
at the value in the table (such as APPCNTR_VERSION) and would not attempt to
upgrade them. When you use Ant tasks, do not run the database target if the
databases are already updated manually. If you do run them, the Ant tasks
would detect that the schema is in V7.1.0.
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* WebSphere Application Server specifics:

— The user that runs the upgrade needs to have at least the privileges of a
Configurator role to install new application. In some cases if a user needs to
be created, or the application security needs to be activated, an Administrator
role is required.

* Upgrade the databases:

— Back up the databases for Application Center. The migration scripts delete
some data in your database and the operation cannot be undone. If you
decide to roll back the upgrade of Application Center, you need this backup.

— If you upgrade manually, the upgrade scripts can be found in
product_install _dir/ApplicationCenter/databases folder.

1. Select the script, depending on your database, to upgrade the database
from V5.0.6 to V6.0.0.

- upgrade-appcenter-506-60-db2.sql
- upgrade-appcenter-506-60-mysql.sql
- upgrade-appcenter-506-60-oracle.sql
2. Upgrade the database from V6.0.0 to V6.1.0.
- upgrade-appcenter-60-61-db2.sql
- upgrade-appcenter-60-61-mysql.sql
- upgrade-appcenter-60-61-oracle.sql
3. Upgrade the database from V6.1.0 to V6.2.0.
- upgrade-appcenter-61-62-db2.sql
- upgrade-appcenter-61-62-mysql.sql
- upgrade-appcenter-61-62-oracle.sql
4. Upgrade the database from V6.2.0 to V6.3.0.
- upgrade-appcenter-62-63-db2.sql
- upgrade-appcenter-62-63-mysql.sql
- upgrade-appcenter-62-63-oracle.sql
5. Upgrade the database from V6.3.0 to V7.0.0.
- upgrade-appcenter-63-70-db2.sql
- upgrade-appcenter-63-70-mysql.sql
- upgrade-appcenter-63-70-oracle.sql
6. Lastly, upgrade the database from V7.0.0 to V7.1.0.
- upgrade-appcenter-70-71-db2.sql
- upgrade-appcenter-70-71-mysql.sql
- upgrade-appcenter-70-71-oracle.sql
— If you upgrade with Ant tasks, do the following steps:

1. Create an Ant file by using one of the configure-applicationcenter-
<appserver>-<dbtype>.xml files in product_install dir/
ApplicationCenter/configuration-samples folder. Take the file that
corresponds to your application server and database.

2. Edit the file and enter the properties at the top of the file.

3. Verify that the parameters you use are the same as the one you use at the
initial installation time.

Check the parameter details such as the server name, the cluster name, the
database, the users, and the schemas. If the database parameters are
different than the ones that are used at the initial installation, the Ant task
might create new empty tables instead of upgrading the tables to the new
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format. If the application servers parameters are not the same as the ones
that used at the initial installation, the Ant task might fail to update the
application.

Installing manually

Procedure

1. Follow the instructions at [Deploying the Application Center WAR files and)|
[configuring the application server manually]

2. Configure Application Center. For more information, see
[Application Center after installation|

Installing with Ant tasks

Procedure

1. Reuse the Ant file that is used to upgrade the database.

2. Run the install target to deploy Application Center to your application server.
For example,
product_install_dir/shortcuts/ant -f your_ant_file.xml install

3. Configure Application Center. For more information, see
[Application Center after installation|

Installing MobileFirst Operational Analytics
Procedure

Install MobileFirst Operational Analytics V7.1.0 as described in [Installing the IBM|
[MobileFirst Platform Operational Analytics}

3-16 IBM MobileFirst Platform Foundation for iOS V7.1.0: Upgrading MobileFirst Server from V5.0.6 to V7.1.0


https://www.ibm.com/support/knowledgecenter/SSHSCD_7.1.0/com.ibm.worklight.installconfig.doc/admin/c_deploying_appcenter_war_files_manually.html
https://www.ibm.com/support/knowledgecenter/SSHSCD_7.1.0/com.ibm.worklight.installconfig.doc/admin/c_deploying_appcenter_war_files_manually.html
https://www.ibm.com/support/knowledgecenter/SSHSCD_7.1.0/com.ibm.worklight.installconfig.doc/appcenter/c_ac_config_after_install.html
https://www.ibm.com/support/knowledgecenter/SSHSCD_7.1.0/com.ibm.worklight.installconfig.doc/appcenter/c_ac_config_after_install.html
https://www.ibm.com/support/knowledgecenter/SSHSCD_7.1.0/com.ibm.worklight.installconfig.doc/appcenter/c_ac_config_after_install.html
https://www.ibm.com/support/knowledgecenter/SSHSCD_7.1.0/com.ibm.worklight.installconfig.doc/appcenter/c_ac_config_after_install.html
https://www.ibm.com/support/knowledgecenter/SSHSCD_7.1.0/com.ibm.worklight.installconfig.doc/monitor/c_op_analytics_installation.html
https://www.ibm.com/support/knowledgecenter/SSHSCD_7.1.0/com.ibm.worklight.installconfig.doc/monitor/c_op_analytics_installation.html

Support and comments

For the entire IBM MobileFirst Platform documentation set, training material and
online forums where you can post questions, see the IBM website at:

[http:/ /www.ibm.com /mobile-docs|

Support

Software Subscription and Support (also referred to as Software Maintenance) is
included with licenses purchased through Passport Advantage® and Passport
Advantage Express. For additional information about the International Passport
Advantage Agreement and the IBM International Passport Advantage Express
Agreement, visit the Passport Advantage website at:

[http:/ /www.ibm.com /software / passportadvantagel

If you have a Software Subscription and Support in effect, IBM provides you
assistance for your routine, short duration installation and usage (how-to)
questions, and code-related questions. For additional details, consult your IBM
Software Support Handbook at:

[http:/ /www.ibm.com /support/handbook]

Comments

We appreciate your comments about this publication. Please comment on specific
errors or omissions, accuracy, organization, subject matter, or completeness of this
document. The comments you send should pertain to only the information in this
manual or product and the way in which the information is presented.

For technical questions and information about products and prices, please contact
your IBM branch office, your IBM business partner, or your authorized remarketer.

When you send comments to IBM, you grant IBM a nonexclusive right to use or
distribute your comments in any way it believes appropriate without incurring any
obligation to you. IBM or any other organizations will only use the personal
information that you supply to contact you about the issues that you state.

Thank you for your support.

If you would like a response from IBM, please provide the following information:
* Name

* Address

* Company or Organization

* Phone No.

* Email address

© Copyright IBM Corp. 2015, 2016 4-1


http://www.ibm.com/mobile-docs
http://www.ibm.com/software/passportadvantage
http://www.ibm.com/support/handbook

4-2  IBM MobileFirst Platform Foundation for iOS V7.1.0: Upgrading MobileFirst Server from V5.0.6 to V7.1.0



Notices

This information was developed for products and services offered in the US. This
material might be available from IBM in other languages. However, you may be
required to own a copy of the product or product version in that language in order
to access it.

IBM may not offer the products, services, or features discussed in this document in
other countries. Consult your local IBM representative for information on the
products and services currently available in your area. Any reference to an IBM
product, program, or service is not intended to state or imply that only that IBM
product, program, or service may be used. Any functionally equivalent product,
program, or service that does not infringe any IBM intellectual property right may
be used instead. However, it is the user's responsibility to evaluate and verify the
operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter
described in this document. The furnishing of this document does not grant you
any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing

IBM Corporation

North Castle Drive, MD-NC119
Armonk, NY 10504-1785

us

For license inquiries regarding double-byte character set (DBCS) information,
contact the IBM Intellectual Property Department in your country or send
inquiries, in writing, to:

Intellectual Property Licensing

Legal and Intellectual Property Law
IBM Japan Ltd.

19-21, Nihonbashi-Hakozakicho, Chuo-ku
Tokyo 103-8510, Japan

INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS
PUBLICATION "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE. Some jurisdictions do not allow disclaimer of
express or implied warranties in certain transactions, therefore, this statement may
not apply to you.

This information could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will be
incorporated in new editions of the publication. IBM may make improvements
and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.

Any references in this information to non-IBM websites are provided for
convenience only and do not in any manner serve as an endorsement of those
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websites. The materials at those websites are not part of the materials for this IBM
product and use of those websites is at your own risk.

IBM may use or distribute any of the information you provide in any way it
believes appropriate without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose
of enabling: (i) the exchange of information between independently created
programs and other programs (including this one) and (ii) the mutual use of the
information which has been exchanged, should contact:

IBM Director of Licensing

IBM Corporation

North Castle Drive, MD-NC119
Armonk, NY 10504-1785

us

Such information may be available, subject to appropriate terms and conditions,
including in some cases, payment of a fee.

The licensed program described in this document and all licensed material
available for it are provided by IBM under terms of the IBM Customer Agreement,
IBM International Program License Agreement or any equivalent agreement
between us.

The performance data and client examples cited are presented for illustrative
purposes only. Actual performance results may vary depending on specific
configurations and operating conditions.

Information concerning non-IBM products was obtained from the suppliers of
those products, their published announcements or other publicly available sources.
IBM has not tested those products and cannot confirm the accuracy of
performance, compatibility or any other claims related to non-IBM products.
Questions on the capabilities of non-IBM products should be addressed to the
suppliers of those products.

This information contains examples of data and reports used in daily business
operations. To illustrate them as completely as possible, the examples include the
names of individuals, companies, brands, and products. All of these names are
fictitious and any similarity to actual people or business enterprises is entirely
coincidental.

COPYRIGHT LICENSE:

This information contains sample application programs in source language, which
illustrate programming techniques on various operating platforms. You may copy,
modify, and distribute these sample programs in any form without payment to
IBM, for the purposes of developing, using, marketing or distributing application
programs conforming to the application programming interface for the operating
platform for which the sample programs are written. These examples have not
been thoroughly tested under all conditions. IBM, therefore, cannot guarantee or
imply reliability, serviceability, or function of these programs. The sample
programs are provided "AS IS", without warranty of any kind. IBM shall not be
liable for any damages arising out of your use of the sample programs.
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Each copy or any portion of these sample programs or any derivative work must include a
© (your company name) (year).

Portions of this code are derived from IBM Corp. Sample Programs.

© Copyright IBM Corp. _enter the year or years_.

Trademarks

IBM, the IBM logo, and ibm.com are trademarks or registered trademarks of
International Business Machines Corp., registered in many jurisdictions worldwide.
Other product and service names might be trademarks of IBM or other companies.
A current list of IBM trademarks is available on the web at "Copyright and
trademark information" at fwww.ibm.com/legal/copytrade.shtml|

Adobe, the Adobe logo, PostScript, and the PostScript logo are either registered
trademarks or trademarks of Adobe Systems Incorporated in the United States,
and/or other countries.

Linux is a registered trademark of Linus Torvalds in the United States, other
countries, or both.

Microsoft, Windows, Windows NT, and the Windows logo are trademarks of
Microsoft Corporation in the United States, other countries, or both.

Java™ and all Java-based trademarks and logos are trademarks or registered
trademarks of Oracle and/or its affiliates.

UNIX is a registered trademark of The Open Group in the United States and other
countries.

Node js is a trademark of Joyent, Inc. and is used with its permission. This
documentation is not formally endorsed by or affiliated with Joyent.

Other company products or service names may be trademarks or service marks of
others.

This document may not be reproduced in whole or in part without the prior
written permission of IBM.

Terms and conditions for product documentation

Permissions for the use of these publications are granted subject to the following
terms and conditions.

Applicability

These terms and conditions are in addition to any terms of use for the IBM
website.

Personal use
You may reproduce these publications for your personal, noncommercial use
provided that all proprietary notices are preserved. You may not distribute, display

or make derivative work of these publications, or any portion thereof, without the
express consent of IBM.
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Commercial use

You may reproduce, distribute and display these publications solely within your
enterprise provided that all proprietary notices are preserved. You may not make
derivative works of these publications, or reproduce, distribute or display these
publications or any portion thereof outside your enterprise, without the express
consent of IBM.

Rights

Except as expressly granted in this permission, no other permissions, licenses or
rights are granted, either express or implied, to the publications or any
information, data, software or other intellectual property contained therein.

IBM reserves the right to withdraw the permissions granted herein whenever, in its
discretion, the use of the publications is detrimental to its interest or, as
determined by IBM, the above instructions are not being properly followed.

You may not download, export or re-export this information except in full
compliance with all applicable laws and regulations, including all United States
export laws and regulations.

IBM MAKES NO GUARANTEE ABOUT THE CONTENT OF THESE
PUBLICATIONS. THE PUBLICATIONS ARE PROVIDED "AS-IS" AND WITHOUT
WARRANTY OF ANY KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING
BUT NOT LIMITED TO IMPLIED WARRANTIES OF MERCHANTABILITY,
NON-INFRINGEMENT, AND FITNESS FOR A PARTICULAR PURPOSE.

IBM Online Privacy Statement

IBM Software products, including software as a service solutions, (“Software
Offerings”) may use cookies or other technologies to collect product usage
information, to help improve the end user experience, to tailor interactions with
the end user or for other purposes. In many cases no personally identifiable
information is collected by the Software Offerings. Some of our Software Offerings
can help enable you to collect personally identifiable information. If this Software
Offering uses cookies to collect personally identifiable information, specific
information about this offering’s use of cookies is set forth below.

Depending upon the configurations deployed, this Software Offering may use
session cookies that collect session information (generated by the application
server). These cookies contain no personally identifiable information and are
required for session management. Additionally, persistent cookies may be
randomly generated to recognize and manage anonymous users. These cookies
also contain no personally identifiable information and are required.

If the configurations deployed for this Software Offering provide you as customer
the ability to collect personally identifiable information from end users via cookies
and other technologies, you should seek your own legal advice about any laws
applicable to such data collection, including any requirements for notice and
consent. For more information about the use of various technologies, including
cookies, for these purposes, see IBM’s Privacy Policy at |http://www.ibm.com/|
rivacy|and IBM’s Online Privacy Statement at [http:/ /www.ibm.com/privacy /|
details| the section entitled “Cookies, Web Beacons and Other Technologies” and
the “IBM Software Products and Software-as-a-Service Privacy Statement” at
Ihttp: / /www.ibm.com/software/info/ product—privacyl
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